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MEITE 

 

INTRODUCTION 

The Motorsport Electronics Integrated Tuning Environment, or ‘MEITE’ for short, is the system used to monitor, 

tune and modify our range of engine management products. Designed for Windows 7, it is built using the latest 

technology to give a fluid user experience, allowing as much (or as little) control as you like, whilst still being 

flexible enough to grow as your knowledge and experience with the system improves. 

The latest version can always be downloaded directly at ​www.motorsport-electronics.co.uk​, and updates can also 

be performed automatically from within the MEITE itself. It also takes charge of updating the connected products 

inbuilt software (called firmware) to bring more features to the product as and when they are released. 

Remember that as well as this manual, online video tutorials are constantly being released on the website - so be 

sure to check back often! 

Please note that for specific products that use the MEITE, such as the ME221 ECU, there exists a separate manual 

(usually available from that product's support page on our website), detailing how its algorithms, options and 

functions work - this manual is designed to cover your interaction with the MEITE, not the featureset of the 

product it is being used to tune. 

INITIAL INSTALLATION 

After downloading the latest version from the website, double click the setup icon from the location where you 

downloaded it, and follow the on-screen prompts to install the software. During the install, if an older version is 

detected, it will automatically be updated to the latest version. 

After installation, an icon will be placed on the desktop, as well as under the start menu ‘All 

Programs/Motorsport Electronics/MEITE’. 

Double clicking on either of these will open the MEITE. 

ONLINE & OFFLINE MODES EXPLAINED 

When using the MEITE, there are two made modes, online, and offline. 

Online is when you are successfully connected to an Engine Management System, and the data shown is a live 

representation of what is contained within the ECU’s memory. Offline is a mode used to edit basemaps and 

calibration files ‘on the bench’, which can at a later time be sent down to the ECU once connected.  

The current connection status is shown in the status bar, at the lower right of the screen, a green tick shows you 

are connected to the ECU - note that the ECU requires power to be connected. If for whatever reason 

communications to the ECU are lost, then clicking the red disconnection icon will attempt to reconnect to the 

ECU. 
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MEITE 

GETTING CONNECTED 

This example covers the ME221 Engine Management Platform. 

The ME221 communicates over a 9 way serial connection. While some older (and industrial) laptops feature this 

connection, most modern laptops to do not, and so a Serial-to-USB adapter, such as the one pictured below will 

be needed. The MEITE has been tested with genuine Prolific and FTDI adapter cables. Note that some cheaper 

chinese copies may not work as effectively, so be sure to either purchase a genuine adapter (around £25) or 

alternatively order direct from our website. 

 

After connecting the comms lead to the ECU (shown in the ECU User Manual) and then via the adapter to the USB 

port on your laptop, Windows will look to install the drivers for the USB adapter automatically. 

The next step, with the MEITE closed, is to turn on the ignition such that the ECU is powered. If the vehicle is fully 

wired then the fuel pump should prime (showing that the ECU is alive and well). 

Now, you can launch the MEITE in the usual way,(Program Files>Motorsport Electronics>MEITE) and it should 

automatically locate the correct communications port, and a green tick should be shown in the comms status bar 

at the lower right of the MEITE, to show that the system is now connected to the controller. After a moment, a 

progress bar will display as the MEITE downloads the current calibration from the controller. You are now ready 

to tune the ECU, in ‘online’ mode. 

If the green tick is now shown, then you use the drop down box in the lower right corner to select a different 

comm port, and then click the red circle to attempt reconnection. 
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MEITE 

FIRMWARE UPDATES 

The MEITE includes the ability to update connected ME products with new firmware versions as they become 

available. 

To access the Firmware Update Tool, ensure you are connected to a system in the usual manner above, then 

from the main menu Tools -> Firmware update, the following dialog will appear: 

 

The connected devices details are shown on the left boxes, including its product code, type and definition file 

version, as well as the current firmware version on the device. 

After selecting a new firmware file via the browse “...” button, (only ​*.mefw ​are supported), the new firmware 

information is shown in the rightmost boxes. 

Newer versions of firmware for your product may be available from our website. Please check often. Automatic 

checking of new firmware versions will be coming soon to the MEITE. 

Simply press ‘Update’ and follow the onscreen prompts. Note that any current calibration is saved to disk 

automatically. 

If you are updating to a newer definition file of your product, the MEITE will automatically extract and store the 

new definition data from the MEFW file, and add it to its internal library of definition files. 
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MEITE 

USER INTERFACE 

Below is a picture of the standard user interface with default, basic, tabs when working ONLINE with an ME221 

Engine Management System. 

 

Areas: 

1. Main Menu Bar 

2. Tab Selection Bar 

3. Tree View 

4. Status Bar 

5. Connection Information 

6. Interface Area 

7. User Widgets 
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MEITE 

MAIN MENU 

The Main menu for the MIETE is along the top of the screen, and gives access to File Loading/Saving features as 

well as tools, datalogging and other MEITE features. 

FILE -> LOAD/SAVE CALIBRATION 

Calibration files can be loaded and saved from the File>Load/Save Calibration menus. 

When saving a calibration, choose the filename and directory as per normal windows usage. The files will be 

stored with the ​*.mecal ​extension. Note that when a calibration is saved, its definition file version is also 

recorded, which is detailed further in the loading of calibrations. 

Loading a calibration will first attempt to send it to the currently connected device, and if the connected device 

matches the definition file version of the calibration file, then it will load, and shortly after the MEITE will 

reconnect to the ECU to create a mirror image of the now updated ECU. If this definition differs, then some areas 

will be left unedited. For example, if you attempt to load on an older calibration which does not use AFR target 

table settings, onto a more modern firmware version which does, then those areas of the ECUs memory will be 

left untouched. When saving the file thereafter, the definition version of the calibration will be updated to that of 

the connected ECU, and all data will be saved to to the file. 

FILE -> EXIT 

This exits the MIETE. The Comm Port (if connected) will be closed. Note that your current calibration file will not 

be saved, and, if the ECU has not had a burn command (by a widgets change of focus, or the ‘S’ button in the 

widgets’ window) then the changes made on the ECU may be lost on the next power-cycle of the ECU. This has 

been changed on a new versions of MEITE (0.8.5+), such that the ECU is requested to store the changes on MEITE 

exit. 

ABOUT 

The About box, as well as presenting contact details for Motorsport Electronics, also displays the ECU Firmware 

version, definition file version and MEITE version information - critical for technical support issues - and required 

in any support discussions. 
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MEITE 

 

STATUS BAR 

The status bar at the bottom of screen shows the connection & ECU status, comm port selection box as well as 

data logging status.  

TABS 

A tab is a selectable display mode which groups & shows widgets. Its used for grouping, such as having a ‘Startup 

Tab’ showing engine settings, and diagnostic data, or a ‘Mapping’ Tab that shows just the fuel and ignition table. 

This method allows grouping of widgets to make tuning and setup very straight forward. In most cases on PnP 

ECUs with a correctly loaded basemap, only the fuel and ignition mappings may need to be tuned. 

The currently displayed, or active Tab is shown by the Tab title being highlighted. Clicking on a different tab will 

close the current tab (saving any changes you have made to the widgets or the layout) and will then open that 

tab. You can also add a new tab at anytime with the ‘Add Tab’ menu item. 

Over time, your prefered way of working will form, with tabs set up as to how you like them, focusing on different 

areas within the ECU. This is the flexibility that the MEITE offers. 

TREE VIEW 

The tree view on the left of the main window, show all the user accessible variables, readouts, configuration 

controls and data tables that the current definition file holds, which of course relates to the areas you can view 

and configure within the ECU.  

Any entity on the tree view can be double clicked, and its default widget type will be added to the current tab 

view. Note that some widget types are specific for a data type, such as a 3D mapping table can not be used to 

show current coolant temperature. 

WIDGETS 

Widgets are items that can be placed on the current view. They range from simple digital readouts, to complex 

3D mapping tables and histograms. 

Any entity on the tree view can be double clicked, and its default widget type will be added to the current tab 

view. Note that some widget types are specific for a data type, such as a 3D mapping table can not be used to 

show current coolant temperature… 

For all data-entry widgets (such as the table, map and configuration views), a border is presented around the 

widget when data operations are happening. On changing a value, the border will turn red, to show the data is 

being sent to the ECU, and then green, to show the ECU has received and has confirmed the data. These changes 

will be lost however if you power cycle the ECU. To avoid this and to long term store this to the ECU, simply click 

the small ‘S’ in the top right, or change focus to another widget. 
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MEITE 

MOVING & RESIZING WIDGETS 

Widgets can be moved by placing the mouse near the upper left corner, and the movement cursor should appear. 

Clicking and dragging will then allow the widget to be moved around the current tab. Likewise, you can resize the 

widget by moving the mouse cursor to one of its edges, and when the bar appears, click and drag to resize 

accordingly. Note that when moving between tabs, widget locations and sizes will be saved to each tabs layout. 

DIGITAL READOUT 

The most simple widget is the Digital ReadOut, or DRO. A DRO is used to show the value of a particular entity, 

such as current coolant temperature, or battery voltage. Its text size will re-scale when resizing the control. 

To alter the DROs significant digits/decimal places, simple right-click, and select it from the context menu that 

appears. You can also set alarms here for high/low level warnings. Note that each individual DRO has its own 

alarms, so you can have two RPM DROs, and different alarm values for each one. Also, an RPM DRO on a different 

tab will also have its own alarm setpoints - bare this in mind when relying on alarms for notification of problems! 

TWO-DIMENSIONAL TABLE 

The Two-Dimensional Table (or 2DT) allows you to edit how an output variable relates to an input, for example, 

shown below, how the coolant correction amount relates to the engines coolant temperature input. 

 

Yellow lines and text on the view show the current ‘real’ results that are being used in the ECU (when online). 
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MEITE 

Also, on the left of this widget is a table view where you can edit both inputs (by double clicking them) and the 

outputs (by pressing backspace on a selected cell). 

You can also drag the blue boxes on the line view up and down to change the data in the graphical sense. 
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MEITE 

THREE-DIMENSIONAL MAP 

The 3D Map view offers the ability to view a map that is used to compute outputs based on two inputs. Typical 

uses for these type of views include the fuel and ignition maps. 

The title specifies where the data comes from, and where the output is assigned. 

 

On the default ‘Grid View’ (above), the current input data points are shown by the cross hair intersection formed 

by the yellow lines - and note that it also considers real-time interpolation to correctly show how far the engine 

or connected system is from the ‘centre’ of the current cell. 

You can move around this grid using the cursor keys, and hit backspace to enter a new number in the popup box 

for the current cell, or simply press ‘Q’ or ‘W’ keys to increase/decrease the current cursor locations cell by the 

fine amount. This can also be done with multiple cells, selected by clicking and dragging the mouse as per normal 

Windows operations (akin to Excel). 

There is also a tick box named ‘Follow’ (shortcut, just hit the ‘F’ key to enable follow mode). With this mode on, 

the current edit cursor will move around the map as the yellow crosshairs do, moving to the most favoured cell - 

this is useful when in a steady state control mode such as on an engine dyno or rolling road. 

Also, there is a ‘3D mode’ which projects the table as a 3D wireframe, colour scaled image. In this case (shown 

below) you have a red dot which represents the engine/systems current real position, and a blue dot which 

represents the cursor. The interaction keys are the same as the ‘grid view’, with the addition of being able to 
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MEITE 

press ‘Control+Cursor Arrow) to rotate the view in that direction. The follow mode also works in the same fashion 

in this view. 

 

CONFIGURATION WIDGET 

The config. widgets are specific modules to handle bespoke control settings on the ECU, such as engine 

configuration, boost control settings, idle valve setup, and so on. 

To edit a value, either use a drop down box or edit the text directly. Once edited, remember to press the ‘enter’ 

key. The border of the Config Driver will turn red briefly (to indicate data has been sent to the ECU) then turn 

green to signify that the ECU has indeed received the data. Like the other data entry widgets, to permanently 

store the data to the ECUs memory (so it remains after a power cycle) either press the ‘S’ in the top right corner, 

or simply close the widget, or click on any other open widget. 

Note that some settings require a power cycle of the ECU after making changes. 

 

 

 

11  
MEITE​ | ​For further support, please visit us online at ​www.motorsport-electronics.co.uk​.  

 

http://www.motorsport-electronics.co.uk/
http://www.nodiz.co.uk/
http://www.nodiz.co.uk/

